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Excel Magic 
The Road to Excellence 

 
 
 

 
 
 
 
 

Excel studies indicate that business professionals spend as much as 50% of their time in Excel working on 
formatting – not checking data inputs, analyzing data, performing what-if analysis, or working activities that add 
meaningful value to an organization. Clearly, there is room for improvement! 
 
In this session we will focus on workbooks and worksheets with a focus on Excel templates.  
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Display of Zeros and Precision as Displayed 
One of the confounding problems of using any of the financial number formats (accounting, 
currency, and number) is the display of zeros. Recall that the third part of any number format 
code is the code to display zeros. However, the format code only applies when the value in a 
cell is equal to zero, not when the value in a cell appears to be zero, such as when a small value 
rounds off automatically to zero for display. This is especially problematic when using the 
accounting format because cells can be displayed as zeros, positive zeros, or negative zeros as 
shown in Figure 1. 

 

Figure 1 - Zero Display Using the Accounting Format 
 

Some practitioners have become so frustrated with this problem that they enter hard-coded zeros 
over formulas when this occurs so that zeros display consistently throughout their reports. In the 
process of overwriting their formulas, however, they potentially corrupt their worksheet so that 
it does not recalculate properly in the future. 

 
There are two easily applied solutions to this problem. The most common solution is to round 
off calculations to the number of displayed decimals. In other words, the values 0.001 or -0.001 
(or smaller) rounded to two decimals would result in a cell value of zero, which would be 
displayed properly when using the accounting format. When a positive or negative zero cell is 
encountered, simply round the contents of the cell to the appropriate number of decimal places 
using the ROUND function. 

 
The second solution to this problem is to enable global rounding in the affected workbook. 
When global rounding is enabled, all values are rounded to their cell formats. In other words, 
the values 0.001 or -0.001 (or smaller) displayed with two decimals would automatically be 
rounded to a cell value of zero, which would be displayed properly when using the accounting 
format. To enable global rounding in a workbook if you use Excel 2010 or newer, click the File tab 
of the Ribbon, Options, Advanced, and in the section labeled When calculating this workbook, 
check the box next to Set precision as displayed and click OK. 

 
If you use Excel 2007, click the Office Button and then Excel Options. Select Advanced 
on the Navigation Bar on the left. In the Option Pane on the right, check Set precision 
as displayed in the section entitled When calculating this workbook. Click OK. 

 
Regardless of which version of Excel is running, enabling global rounding in a workbook causes 
Excel to display the warning shown in Figure 2. 
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Figure 2 - Warning message displayed when 
Precision as Displayed is enabled 

 
Do not be alarmed by the warning. Click OK, and all of the cells that contain zeros will now 
display properly. 

 
Before continuing, an explanation of the warning message is in order. To do that, we must first 
review how Excel makes calculations. In default, Excel rounds off for display but uses the 
underlying data to make calculations. Precision as displayed alters the way that Excel evaluates 
formulas. With precision as displayed enabled, Excel ignores the underlying data and uses the 
data displayed on the screen to make calculations. Hence, when precision as displayed is 
enabled, all calculations will foot and cross-foot properly. In other words, practitioners will not 
encounter the proverbial one-cent rounding error that often results in worksheets because 
the numbers displayed on the screen are used to make the calculations. The example in 
Figure 3 will help in explaining precision as displayed. 

 

Figure 3 - Rounding Error Corrected by Enabling Precision as Displayed 
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Note the one-cent (least significant digit) rounding error in the table at the top of Figure 3. The 
total displayed is $297.71 but should read $297.72. The error occurs because Excel is using the 
underlying data shown in the column displayed on the right to make the calculation. In the 
bottom table, precision as displayed has been enabled. In this case, Excel is using the data 
displayed on the face of the worksheet to make the calculation, and the rounding error 
disappears. 

 
Now, we can get back to the warning message that appears when precision as displayed is 
enabled. The warning message refers to a problem that can arise when we enter constants 
(numbers) in a worksheet and do not display all of the decimals entered. In this circumstance, 
any decimals not displayed are truncated. For example, if we entered 2.2385 in a cell and 
displayed only two decimal places, the contents of the cell would be truncated to 2.24 if 
precision as displayed were enabled. Furthermore, if we tried to undo our change, we would 
find that this change cannot be undone – it is a permanent change. Under these circumstances, 
it would be wise to save workbooks before enabling precision as displayed. 

 
Note that this issue does not arise when cells contain formulas. In other words, precision as 
displayed can be enabled or disabled at will without any impact on the accuracy of the 
underlying data when the data results from formulas. Since most, if not all, of our rounding 
issues result from floating point calculations, and since most practitioners are not likely to type 
in constants with more decimal places than are displayed, precision as displayed is not likely to 
pose a problem in day-to-day practice. In fact, many accounting professionals have altered their 
default templates, book.xltx and sheet.xltx, to enable precision as displayed so that all 
workbooks foot and cross-foot properly without using the round function in formulas. In those 
cases where precision as displayed is desired without permanent truncation of data on constants, 
simply preface the entry of the constant with an equals sign (=). Excel will treat the entry as a 
formula and precision as displayed will work to solve rounding and footing issues, yet because 
the formula is volatile in nature and recalculates, data is not permanently truncated. 

 

 If you import or rekey financial data into a worksheet and then display the data 
in thousands, millions, or billions using custom number formats as illustrated 
earlier in this chapter, and you enable precision as displayed to eliminate 
rounding errors in the resulting reports, your keyed data will be truncated. 
Make sure to save your original workbook with a different filename before 
enabling precision as displayed. A better solution would be to use formulas to 
create another worksheet in your workbook on which to apply the custom 
formats. Since the cells on the new worksheet contain formulas instead of 
constants (your imported or keyed numbers), precision as displayed can be 
enabled or disabled at will without affecting the data on your original 
worksheet. 
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Templates 
 

There are two major advantages of converting pre-configured workbooks into templates. 
1. Users do not waste time finding infrequently used templates because template files are stored in 

a common location. To open a template, select New from the File tab of the Ribbon in Excel 2010 
or 2013, or from the Office Button in Excel 2007. In the New Workbook dialog box, double-click 
on the template from which to create a new workbook as shown in Figure 4.  

2. Users do not have to waste time cleaning up a template after inadvertently saving data in a pre-
configured workbook (.xlsx) file. If users are entering data in a previously unsaved template (.xltx), 
Excel displays the Save As dialog box when choosing to Save the workbook. In other words, users 
cannot easily save data over a template file, which relieves them of the time-consuming task of 
cleaning up a pre-configured workbook when they inadvertently overwrite one.  

 
Figure 1 - Opening a Template in Excel 

To convert pre-configured workbooks to templates, simply save the workbooks as template files. First, 
open a pre-configured workbook. Then use the keyboard shortcut F12 to open the Save As dialog box. 
Select Excel Template in the Save as type drop-down box at the bottom of the Save As dialog as shown 
in Figure 5. Type in a descriptive name for the template and click Save. 
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Figure 5 - Saving a Workbook as a Template 

 

 
Note that the process described above saves a copy of the workbook as a 
template. The original workbook will still be available in its original folder. In 
addition, templates can be updated by simply saving a newer version over an 
older template. To delete a template that is no longer used, navigate to the 
Custom Office Templates folder and delete the file. 

 
Understanding and Modifying Excel's Default Templates 
Now that we have covered the fundamentals of templates, let's examine Excel's default templates, 
book.xltx and sheet.xltx. These two files control Excel's user environment. A copy of book.xltx with all of 
its settings is opened each time Excel is opened or whenever a new blank workbook is created. Likewise, 
Excel inserts a copy of sheet.xltx with all of its settings whenever a new worksheet is inserted into an 
existing workbook. Modifying these files allows users to customize their work environment in ways that 
are not generally possible through the user interface. 
Let's take just one example. Most accounting professionals would change the default number format 
from General to the Accounting format if they knew how. Changing the default number format is not 
possible through the GUI, but it is just a simple process for those who understand the significance of the 
default templates. 
To change the default number format to the Accounting format, follow these steps. 

1. Open a blank workbook. 

2. On the Home tab of the Ribbon, select Cell Styles. In the Style Gallery, right-click on the Normal 
style and choose Modify. 

3. In the Style dialog box, click Format. 

4. On the Number tab of the Format Cells dialog box, select Accounting with 2 Decimal places and 
Symbol as None.  
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5. Set precision as displayed (global rounding), 

6. Create any custom headers and footers, and named styles. 

7. Click OK to close the Format Cells window and OK to close the Style window. 

8. Save the blank workbook as book.xltx in the XLstart folder. 

9. Delete all sheets but one and save the workbook as sheet.xltx in the XLstart folder. 

To Locate the XLStart folder 

Any workbook, template, or workspace file that you place in the XLStart folder is automatically opened 
when you start Excel. To find out the path of the XLStart folder, check the Trust Center settings. To do 
so: 

1. Click File > Options. 
2. Click Trust Center, and then under Microsoft Office Excel Trust Center, click Trust Center 

Settings. 
3. Click Trusted Locations, and then verify the path to the XLStart folder in the list of trusted 

locations. 

 
Figure6 – Finding the Location of the XLSTART Folder 
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That's it! The next time Excel is opened, or a user clicks on the New workbook button, the new settings 
will be pre-configured in the workbook created. In our opinion, any settings made repetitively in nearly 
every workbook should be included in the default templates. Here are some common settings that may 
be included in the book.xltx and sheet.xltx: 
 

 
The changes made to the default templates have a prospective impact only. 
The new settings only affect workbooks created after the changes are made 
and do not have any influence on existing workbooks unless a new worksheet 
is inserted into an existing workbook. In that case, only the new worksheet will 
be affected. 
 
Note that any settings made by using the default workbooks can be modified 
within the individual workbooks created. For example, Precision as Displayed 
may be set in the default templates, but that does not preclude a user from 
turning off the setting in an individual workbook created from the default 
templates. 

 
Compiled Financials 
The Compiled Financials workbook is less of a template than a demonstration vehicle for illustrating 
advanced techniques useful in constructing templates. Many of the techniques used have already been 
discussed, but we have put them all together, with a few new tricks, in this workbook. There are eight 
worksheets in the workbook: Assumptions, Ad Hoc Notes, Cover, TOC, Compilation Report, Balance 
Sheet, Results of Operations, and Notes to Financials. Let us examine the Assumptions sheet first. 
All other sheets link to the Assumptions worksheet. This worksheet contains cells for the entry of the 
company name and location, fiscal year beginning and end, reporting period, period end date, inventory 
valuation method, depreciation method, and the date of the compilation report. Formulas compute the 
fiscal year end, prior year, and the financial reporting date. Many of the assumptions are entered using 
form controls. As the information changes on the Assumptions worksheet, the changes link through to 
the other worksheets, thereby updating them for any changes in assumptions. For example, as the 
company name and location is changed, every reference to the company name and location updates in 
the other sheets, even on the Cover and the Compilation Report worksheets that contain embedded 
Word documents. 

 
To update the embedded Word documents, double-click on each one of the 
documents to activate (open) them. The Word documents will update the links 
on activation. Click outside of the embedded document to deactivate (close) 
the document. 

 
Figure 65 shows the data entry section of the Assumption worksheet. The cells with light blue 
background are computed. Note the company name in cell C4. That cell links using simple formulas to 
the headings of the Balance Sheet, Results of Operation, and Notes to Financials. The cell is also linked 
into the embedded Word documents using Paste, Paste Special, Unformatted Text with link as 
described in Chapter Two. The same process was used in linking the company location, period, period 
end date, and compilation report date to the embedded Word documents. 
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Figure 7 - Data Entry Section in the Assumption Worksheet 

Several of the inputs are entered using form controls. For example, the current year reporting period is 
input using a spinner control, which we discussed earlier in this chapter. The other controls are 
combination list box (combo box) controls. The setup for a combo box is significantly different from a 
spinner. Let us examine the steps to set up a combo box for the inventory valuation method. 
A combo box requires a list of values (input range) from which the user will select and a target cell (cell 
link) within which the control will return the row number of the value selected. We will use defined 
names for both the input range and the cell link. All defined names for the combo box controls in 
Compiled Financials are in plain view just to the right of the data input section of the Assumptions 
worksheet as shown in Figure 7. Note that the name of each defined name is shaded in green, and the 
actual range of the defined name is shaded in light green. In an actual template, the defined names 
would likely be hidden on another sheet. 

 
Figure 7 - Defined Names for Inventory Valuation Combo Box 
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To create the defined names, follow the process described below. 
1. Enter the labels shown in Figure 8 in a single column with appropriate spacing. Make sure to enter 

them just as they are to be used. In our example, the inventory valuation method will be 
concatenated with other text to form a footnote on accounting policies, so they are entered in 
lowercase just they are to appear in the footnote. 

2. Highlight the range containing the labels "first-in first-out" through "specific identification." Now, 
type in the name InvVal in the Range Box just below the Ribbon. Repeat the process for the 
defined name InvValRow. Note that this defined name will include one blank cell. The defined 
name will not have data in the cell, as is shown above, before the combo box is used for the first 
time. 

Now that the precedent-defined names are created, add a combo box to the worksheet. 
1. Make sure that the Insert Controls button appears on the QAT. 

2. Click on the Insert Controls button and select the control that you want to add. In this case, choose 
the Combo Box as shown in Figure 67. 

 
Figure 8 - Selecting a Combo Box Control on the Forms Toolbar 

3. Click on the worksheet at the location where you want to place the control and drag the control 
to the appropriate size. In this case, we placed the control just over cell C9. 

4. Right-click on the control and choose Format Control. Enter the data as displayed in Figure 9. 
Note the use of the defined names in place of cell references when specifying the Input range and 
Cell link. 
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Figure 9 - Formatting a Combo Box Form Control 

The other combo boxes for fiscal year end, depreciation method, period, and period end are created 
and formatted similarly. Now, let us examine how the inventory valuation method selected in the 
combo box is used in the workbook. Navigate to the Notes to Financials worksheet and then to 
paragraph C of the Summary of Significant Accounting Policies as shown in Figure 10. The second 
sentence in that paragraph uses a formula to concatenate the inventory valuation method selected in 
the combo box. 

 
Figure 10 - Footnote Built Using Selection from Combo Box 
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Here is the formula to construct the paragraph. 
="Inventories are stated at the lower of cost or market. Cost is determined using the 

"&INDEX(InvVal,InvValRow,1)&" method." 
In this case, the inventory method is chosen using the INDEX function with reference to the defined 
names InvVal and InvValRow. As the values in those defined names change, the sentence updates 
automatically to reflect the change. 
Also used in this worksheet are Camera pictures to produce supplementary schedules in the footnotes 
as shown in Figure 11. 

 
Figure 11 - Using Camera Objects for Supplemental Schedules in Footnotes 

The Camera ranges are located on the Ad Hoc Notes worksheet. Camera pictures are used so that the 
supplemental schedules can have column widths and formatting independent of the general area in 
which they are inserted. The use of Camera pictures is covered in Chapter Two. 
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